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1
Introduction

Welcome to the OW5000 Dialer Installation Guide. This guide provides 
the information you need to install and configure the Dialer application. 

Chapter Topics • About Dialer
• How This Guide is Organized
• Using This Guide

About Dialer

Dialer is an OW5000 Windows 2003 service that enables Dterm users to 
access a corporate-wide directory on their telephone display. With 
OW5000 Dialer, you can search the entire corporate directory for a 
telephone number or search the directory of a specific division or 
department.

Once OW5000 Dialer locates the name or location that you are looking 
for, it displays the information on your NEC Dterm telephone. You can 
then place or transfer a call to the telephone number corresponding to 
that entry.

Database entries are stored in the same database used by other 
OW5000 applications such as the UA5200 Client. Queries to the 
database are dynamic. Any changes to directory items will immediately 
be available in OW5000 Dialer. 

How This Guide is Organized

Chapter 1 
Introduction

This chapter outlines how to use the manual, including the organization, 
chapter layout, and conventions used in the OW5000 Dialer Installation 
Guide.

Chapter 2 
Installing Dialer

This chapter details the procedures required to install the Dialer 
application.

Chapter 3 
Configuring Dialer

This chapter describes the functions and associated screen displays for 
configuring Dialer in OW5000 Administrator.

Chapter 4 
NEAX Command 

Assignments

This chapter specifies the procedures to configure the PBX settings 
required by the Dialer application.
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Using This Guide

This guide is designed to make the installation process easy to 
understand and simple to use. There are examples of the screens 
displayed during the Dialer installation with step-by-step instructions for 
the procedures you need to perform.

Document Conventions

This guide uses the conventions shown in Table 1-1.

Table 1-1  Document Conventions 

When you see: It means: Example

Boldfaced 

• Field names

• Button names

• Drop-down list names

• Commands, keywords, or 
other user input

Enter the ID in the Name field.

Click Save.

Select the names from the 
Employees drop-down list.

Enter login admin at the command 
prompt. 

Capitalized 

• Menu names

• Window names

• Dialog box names

From the File menu, choose Save.

From the Directory window, select 
Edit > Modify. 

Click OK to save and close the 
Account Properties dialog box.

Menu > Submenu
(boldfaced font) • Menu paths Select Edit > Modify.

CTRL+S

(boldfaced font)

CTRL+Shift+S

• Shortcut keys Press CTRL+S to save your changes.

F1

(boldfaced font)
• Function keys Press F1 to access the online help. 

Click

Right-click

• Click the left mouse button

• Click the right mouse button

Click OK to save your changes. 

Right-click and select Delete from the 
shortcut menu.

Warning 
Used to warn against possible human 
injury or risk of death from an action or 
event.

Caution Used when equipment or data could 
be damaged by an action or event. 
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Procedures

Step-by-step instructions are numbered. Simply follow the numbered 
steps to perform the desired function.

Sometimes in step-by-step instructions, you will have more than one 
option to complete the task. These options are presented in bulleted 
lists, as shown in the following example: 

Step Do one of the following to add a field to the Employee directory. 

—Select the desired field from the Employee field and click Add. 

—Double-click the desired field from the Employee field.

—To select all of the available fields, click Add all.

Important Emphasizes a MUST read statement.

Note

Used to point out special details that 
you must know or actions that you 
must take relevant to your current 
actions.

Tip
Describes time-saving ideas and 
other useful information for 
completing procedures.

Reference Indicates a reference to another 
related document.

When you see: It means: Example
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2
Installing Dialer

This chapter provides step-by-step procedures to install and configure 
the components of the Dialer software.

Chapter Topics • Before Starting the Installation Procedure
• Installing Dialer

Before Starting the Installation Procedure

This section describes the required components that must be in place 
before installing the OW5000 Dialer software.

Each PBX must be configured for use with OAI before installing the application 
software.

OW5000 Server 

Prior to installing any OW5000 software or Microsoft database, please 
refer to the Requirements section in the OW5000 System Manual to 
verify that your system meets the Application Environment 
requirements for the OW5000 Runtime Platform and specific OW5000 
application software you purchased. 

The OW5000 Runtime Platform must be installed before you install the 
Dialer application. For instructions on how to install the OW5000 
Runtime Platform, refer to the OW5000 System Manual. 

NOTE
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Installing Dialer

Use the following steps to install the Dialer software.

Step  1 Place the OW5000 CD into the computer’s CD-ROM drive. On most 
computers, setup will automatically start when the CD is loaded. If 
Autorun is not enabled on the computer, then do the following:

—After placing the OW5000 CD into the computer’s CD-ROM drive, 
open Windows Explorer and double-click the CD-ROM drive icon.

—Open the Dialer folder and double-click the Setup.exe file. 

Step  2 From the OW5000 Installation Menu, choose Dialer. The Welcome to the 
InstallShield Wizard for OW5000 Dialer dialog box displays (Figure 2-1).

Figure 2-1  OW5000 Dialer - InstallShield Wizard - Welcome dialog box

Step  3 Click Next. The Destination Folder dialog displays (Figure 2-2).
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Figure 2-2  OW5000 Dialer - InstallShield Wizard - Destination Folder dialog box

Step  4 Do one of the following:

—To install to the default folder, click Next.

—To select a different location, click Change, select the desired location 
from the following dialog box, then click Next. A Database Server 
dialog box displays (Figure 2-3).
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Figure 2-3  OW5000 Dialer - InstallShield Wizard - Database Server dialog box

Step  5 Select the database server where the installation will occur using the 
Database server that you are installing to field drop-down, or by 
clicking Browse to select the server. 

Step  6 Specify the authentication method by selecting one of the options listed 
under the Connect using section.

Step  7 Enter the name of the database catalog, or use Browse to select the 
catalog.

Step  8 Click Next when finished. A Logon Information dialog box displays 
(Figure 2-4)
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Figure 2-4  OW5000 Dialer - InstallShield Wizard - Logon Information dialog box

Step  9 Enter your OW5000 account user name in the User name field. The 
User name format is domain\Username or Username if the account is 
on the local machine. This User name must have administrator rights on 
the target machine.

Step  10 Enter the password associated with this user name in the Password 
field.

Step  11 (Optional) Select New User Information to enter information about a 
new user during installation.

Step  12 Click Next to continue the installation. A Ready to Install Program dialog 
box displays (Figure 2-5).
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Figure 2-5  OW5000 Dialer - InstallShield Wizard - Ready to Install Program dialog box

Step  13 Click Install to begin the installation. A Serial Number/Activation Key 
dialog box displays (Figure 2-5).
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Figure 2-6  OW5000 Dialer - InstallShield Wizard - Serial Number/Activation Key dialog box

Step  14 The Serial Number and Activation Key for this installation is 
automatically entered during the initial installation. Click Next or do the 
following:

—Click Refresh if the serial number/activation key was previously 
displayed and is not displayed now.

The serial number for this installation will determine which database will be used for 
OW5000. 

•If the serial number that you are using contains P60 or below, or P65 and Microsoft’s 
SQL Server 2005 is not installed, Microsoft Data Engine (MSDE) database will be 
installed. 

•If you desire to run a P65 serial number and use Microsoft’s SQL Server 2005, then 
SQL Server 2005 must be installed prior to the installation.

•If the serial number contains P70 or above, Microsoft’s SQL Server 2005 must 
already reside on the OW5000 machine. If it has not yet been installed, cancel this 
installation, install SQL Server 2005, and re-run this installation.

Make sure the security key or dongle is securely in place.

NOTE

NOTE
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Step  15 If you were given additional serial numbers/activation keys to 
enable multiple PBX nodes, click the Add Serial Number 
button. If additional serial numbers were found on the OW5000 
CD or on the computer, they will be listed in the Add Additional 
Serial Numbers box. See Figure 2-7. 

Figure 2-7  Add Additional Serial Number dialog box

Step  16 Type in the additional serial number/activation key and click OK. The 
Serial Number/Activation Key dialog box displays listing the additional 
serial number/activation key.

Step  17 Click Next to continue. An Application PBX Configuration dialog box 
displays (Figure 2-8). 
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Figure 2-8  Application PBX Configuration dialog box

Step  18 If the target PBX is listed in the PBX Selection List, do one of the 
following:

—Review and modify the PBX settings, as shown in Figure 2-10. 

—Activate the target PBX for use with this application, as shown in 
Figure 2-11 on page 13. 

Step  19 If PBXs need to be added, click Add New PBX. A New PBX dialog box 
displays (Figure 2-9).
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Figure 2-9  New PBX dialog box

Step  20 Enter a PBX Name for the PBX in the PBX Name field. This is a label 
used to identify the PBX. It is viewable on various list boxes to identify 
the location of extensions, and therefore, should be made descriptive 
such as the site location, etc.

Step  21 Enter the PBX IP address in the IP Address field. If you do not know the 
PBX IP Address, contact your local PBX system administrator. 
Determining the IP address of your PBX depends on the particular type 
of PBX, as shown in Table 2-1.

Table 2-1  PBX Type and IP Address Location

PBX Type IP Address Location

NEAX 2400 IMS - Internal IP ASYDL locations 515-518

NEAX 2000 IPS 0B command

UNIVERGE SV7000 ADTM command
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Step  22 Enter the PBX ID for the PBX in the PBX ID field. This is the PBX’s office 
code. This ID is used by applications to match extensions provided in 
OAI messages sent from the PBX with a given extension in the OW5000 
database. This ID uniquely identifies the PBX and is critical in a CCIS 
environment that does not have a unique numbering plan (where 
extensions can have the same number in more than one networked 
PBX).

Step  23 Select the PBX Type from one of the selections in the PBX Type drop-
down list.

Step  24 Enter a unique RMI Bind Name for the PBX in the RMI Bind Name field. 
This is simply a unique identifier so that remote applications can 
communicate with the Java OAI Server using RMI.

Step  25 Select an available Client Server Port from the drop-down list. This port 
is used by remote applications to communicate with the Java OAI Server 
using TCP/IP.

Step  26 Select the Split Call Forward check box if this feature is configured on 
your PBX. Split Call Forwarding enables Dterm telephone users to set 
different call forwarding patterns for internal versus external calls.

Step  27 After entering the information, click OK. An Application PBX 
Configuration dialog box displays with the new PBX added to the PBX 
Selection List (Figure 2-10). 

Figure 2-10  Application PBX Configuration dialog box—New PBX added to List

If Dialer is running on more than one PBX, repeat the steps to add a new PBX until 
all the required PBXs have been added.

Step  28 When all PBXs have been entered, configure each PBX by selecting the 
following information from the fields in the PBX Selection List (Table 2-2).

Table 2-2  PBX Selection List

NOTE

Field Name Description

Port This field specifies the TCP/IP port number that 
the application uses when connecting to the PBX. 

Use the following port values for the PBX in use:

• NEAX 2000 IPS PBX, NEAX 2400 IMS Internal 
IP PBX, and UNIVERGE SV7000 ports are 
always 60030.
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Force Port This field has the following settings:

• Yes specifies that the application uses the same 
port each time it runs. This should be selected 
to avoid problems with clearing 
D<Superscript>term displays and monitoring 
equipment.

• No specifies that the application will retry one of 
the other port numbers when the application 
fails to connect to the PBX because the port 
may be in use by another application. (This 
setting has no effect when the PBX Type is 
NEAX 2000 IPS, NEAX 2400 IMS Internal IP, 
or UNIVERGE SV7000.) 

You should normally select Yes for the Force Port 
field.

Heartbeat This field has the following settings:

• Yes specifies that the application checks 
approximately every 20 seconds to make sure 
the PBX connection is still alive and operational. 

• No specifies that the application will not check 
the PBX connection.

You should normally select Yes for the Heartbeat 
field.

Data Mode The Data Mode specifies which OAI Key code is 
mapped to the Function Key on the 
D<Superscript>term that invokes the application.

The value ranges from 128 to 191 and should 
match the OP-CODE in the AOKC command on 
the NEAX 2400 IMS or the D70 command if using 
the NEAX 2000 IPS.

LED Number The LED Number specifies which LED on the 
D<Superscript>term will light when the application 
is active. 

The value ranges from 1 to 16 and corresponds to 
the KEY-CODE in the AOKC command on the 
NEAX 2400 IMS or the OAI Function Key number 
of the D70 command if using the  NEAX 2000 IPS. 

OAI Timeout The OAI Timeout specifies the amount of time that 
the application will wait for user input before 
exiting on that person’s D<Superscript>term. 

The OAI Timeout Value is typically set to 15 
seconds.

Field Name Description
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Step  29 Select the Selected check box for the PBX on which Dialer will run to 
activate that PBX for use with Dialer. The selected PBX is highlighted 
and a check mark displays in the Selected field in the PBX Selection List 
(Figure 2-11).

Figure 2-11  Application PBX Configuration dialog box—Selecting a PBX on PBX Selection List

When selecting a PBX, a field highlighted in yellow indicates a conflict with another 
application on the same PBX. Click on the highlighted field to view a drop-down list 
showing the applications already associated with the range of values for this field. 

Incremental 
Retry Delay

The Incremental Retry Delay specifies the amount 
of time the application waits to attempt to 
reconnect to the PBX after the connection is lost. 

When the connection to the PBX is lost, the 
application waits for the amount of time specified 
in the Incremental Retry Delay field before 
attempting the first attempt to reconnect. If the 
connection still can’t be made, the specified 
amount of time will be added to the delay period 
before the next attempt. For example, if the 
Incremental Retry delay is set to 30 seconds, the 
application waits 30 seconds before attempting to 
reconnect. If that first attempt fails, the application 
waits 60 seconds before making a second attempt 
to connect, then waits 90 seconds before making 
a third attempt, and so on. When the application 
successfully reconnects to the PBX, the delay 
time goes back to the amount of time set in the 
Incremental Retry Delay Value field.

Incremental Retry Delay Value is typically set to 
30 seconds.

Max Retry Delay The Max Retry Delay specifies the maximum 
amount of time the application waits between 
attempts to reconnect to the PBX after the 
connection is lost. 

This is used in conjunction with the Incremental 
Retry Delay and ensures that the application will 
try to re-establish a connection to the PBX within 
a certain amount of time. 

The Max Retry Delay Value is typically set to 1 
hour to make sure that the application will attempt 
to reconnect to the PBX at least once an hour.

Field Name Description

NOTE
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Step  30 If PBXs need to be deleted, click Remove PBX. A Remove PBX dialog 
box displays (Figure 2-12).

Figure 2-12  Remove PBX dialog box

Step  31 Select the PBX that is to be removed from the drop-down box, then click 
OK.

Step  32 After making all changes needed in the Application PBX Configuration 
dialog box, click Next..

—Once all the files are copied to your computer, a InstallShield Wizard 
Completed dialog box displays (Figure 2-13).



Installing Dialer         2-15

OW5000 Dialer Installation Guide - Revision 10

Figure 2-13  Completed Dialer Installation dialog box

Step  33 Click Finish. The dialog box closes and the computer reboots. The 
Dialer installation program is now complete.
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3
Configuring Dialer

OW5000 Administrator is an OW5000 Runtime Platform utility used to 
configure OW5000 applications and tools. It also provides a graphical 
user interface to modify OW5000 user account information.

OW5000 Administrator provides a view of database information, login 
settings, installed machines, installed applications under each machine, 
and application settings. You may browse and request modifications to 
the system repository by clicking on the desired application in the 
navigation pane.

The functions and associated screens that display for configuring Dialer 
in OW5000 Administrator are described in this chapter.

The following topics are included in this chapter.

Chapter Topics • Configuring the General Options
• Configuring the PBX Settings Options
• Configuring Dialing Properties

Configuring the General Options

You must login to the OW5000 Administrator in order to configure 
Dialer. Refer to the OW5000 System Manual for information on how to 
login to the OW5000 Administrator. When you have finished configuring 
the application, you can either log out or just close your browser.

The following options are originally configured during either the 
OW5000 Runtime Platform installation or during Dialer’s installation 
process. They may be reconfigured through OW5000 Administrator by 
completing the following steps.

Step  1 Login to the OW5000 Administrator program. Once you are logged in to 
the OW5000 Administrator, follow this path to open Dialer’s configuration 
options: OW5000 > Applications > Dialer. Figure 3-1 displays.
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Figure 3-1  Dialer Manager dialog box

Step  2 Select the Name/Extension check box to configure Dialer to display the 
station extension with the name found by Dialer on the user’s Dterm 
LCD.

Unchecked is the recommended configuration for the Name/Extension option. If 
unchecked, the name of the queried person will not be truncated to accommodate 
the extension, giving the user the benefit of seeing a full 16 characters. The 
extension can then be displayed by scrolling to the right to view the next LCD screen 
of information. See the OW5000 Dialer User Guide for more information.

Step  3 Select the Global List check box to configure Dialer to allow users to 
search with the name only. If this option is not selected, Dialer will prompt 
the user to query divisions, departments, and finally the name.

Step  4 Click Apply after you have completed your changes.

In order for the changes to become active, you must stop the Dialer application via 
the WatchDog Helper and allow WatchDog to restart the application. (See the 
OW5000 System Manual for more information.) Because the application will not be 
accessible during this process, it is best to wait until off hours to stop the application.

NOTE

NOTE



Configuring Dialer         3-3

OW5000 Dialer Installation Guide - Revision 10

Configuring the PBX Settings Options

Select the PBX Settings tab located on the Dialer Manager dialog box 
(Figure 3-1). The PBX Settings dialog displays (Figure 3-2). This dialog is 
used to assign the PBX to which Dialer will connect. 

Figure 3-2  PBX Settings Configuration Options dialog box
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Step  1 From the PBX Settings dialog box, select the PBX you want to modify 
from the PBX drop-down menu. 

Step  2 Verify the desired value for Port

This field specifies the TCP/IP port number that the application uses 
when connecting to the PBX. Use the following port values for the PBX in 
use:

—NEAX 2000 IPS PBX, NEAX 2400 IPX PBX, and UNIVERGE SV7000, 
SV8300, and SV8500 ports are always 60030.

Step  3 Verify the value for Force Port.

This field has the following settings:

—Yes specifies that the application uses the same port each time it runs. 
This should be selected to avoid problems with clearing Dterm 
displays and monitoring equipment.

—No specifies that the application will retry one of the other port 
numbers when the application fails to connect to the PBX because the 
port may be in use by another application. This setting has no effect 
when the PBX Type is NEAX 2400 IPX, UNIVERGE SV7000, SV8300, 
and SV8500, or NEAX 2000 IPS.

You should normally select Yes for the Force Port field.

Step  4 Verify the setting for Heartbeat.

This field has the following settings:

—Yes specifies that the application checks approximately every 20 
seconds to make sure the PBX connection is still alive and 
operational.

—No specifies that the application will not check the PBX connection.

You should normally select Yes for the Heartbeat field.

Step  5 Check the Selected checkbox if you would like Dialer to attempt to 
connect to this PBX the next time it is restarted. 

Step  6 You can change the Data Mode that Dialer uses to communicate with 
Dterm users by selecting an available Data Mode from the drop down 
list. The data mode you select must be programmed for use with OAI in 
the PBX, and it must be assigned to a function key button on each user's 
Dterm in order for Dialer to be available to the user.

The value ranges from 128 to 191 and should match the OPCODE in the 
AOKC command on the NEAX 2400 IPX or the D70 command if using 
the NEAX 2000 IPS.

Step  7 You can change the LED Number that Dialer lights when active on the 
Dterm.

The value ranges from 1 to 16 and corresponds to the KEYCODE in the 
AOKC command on the NEAX 2400 IMS or the OAI Function Key 
number of the D70 command if using the NEAX 2000 IPS. This value 
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has nothing to do with the actual function key assigned on the user's 
Dterm.

Step  8 You can modify the amount of time that Dialer waits for user input before 
exiting on that person’s Dterm.

Step  9 If needed, you can modify the Incremental Retry Delay. The 
Incremental Retry Delay designates the amount of time the application 
waits to attempt to reconnect to the PBX after the connection is lost. If 
the connection to the PBX is lost, Dialer waits for the amount of time 
specified in the Incremental Retry Delay field before attempting the first 
attempt to reconnect. If the connection still cannot be made, the specified 
amount of time will be added to the delay period before the next attempt. 
For example, if the Incremental Retry delay is set to 30 seconds, Dialer 
waits 30 seconds before attempting to reconnect. If that first attempt 
fails, the application waits 60 seconds before making a second attempt 
to connect, then waits 90 seconds before making a third attempt, and so 
on. When the application successfully reconnects to the PBX, the delay 
time goes back to the amount of time set in the Incremental Retry Delay 
Value field. Incremental Retry Delay Value is typically set to 30 seconds.

Step  10 The Max Retry Delay specifies the maximum amount of time the 
application waits between attempts to reconnect to the PBX after the 
connection is lost. This is used in conjunction with the Incremental Retry 
Delay and ensures that the application will try to re-establish a 
connection to the PBX within a certain amount of time. The Max Retry 
Delay Value is typically set to 10 minutes to make sure that the 
application will attempt to reconnect to the PBX at least once an hour.

Step  11 Click the Apply button. 

In order for the changes to become active, you must stop the Dialer application via 
the WatchDog Helper and allow WatchDog to restart the application. (See the 
OW5000 System Manual for more information.) Because the application will not be 
accessible during this process, it is best to wait until off hours to stop the application.

Configuring Dialing Properties

Before using Dialer, you must specify the properties the server uses to 
dial calls. These settings can be configured in the OW5000 
Administrator. See the OW5000 System Manual for more information.

NOTE
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4
NEAX Command Assignments

This guide assumes that data settings that affect the operation of all OAI 
software on a system-wide basis have already been assigned on the 
NEAX 2400 and the NEAX 2000. Such settings include, for instance, 
system index values. For more information about the system data 
settings and about the Dialer settings discussed in this section, refer to 
the following technical manuals for the specific NEAX system in use:

• OAI System Manual
• Command Manual
• Job Specification
• Feature Programming Manual
• System Manual

The following topics are included in this chapter. 

Chapter Topics • NEAX 2400 Commands
• NEAX 2000 Commands

Dialer requires assignment of the Mode Set Facility (MSF) to an OAI-
assigned function key on any D<Superscript>term affected by an 
application. This process involves assigning the MSF and its Operation 
Code (Op-Code), configured for Dialer to one of the 14 OAI Key Codes. 
(The MSF Op-Codes range from 128 to 191.) Each of the OAI Key Codes 
corresponds to an AKYD Function Key Index (FKI) value which is then 
assigned to the specific Dterm function key. Figure 4-1 illustrated this 
process.
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Figure 4-1  OAI Function Key Assignment
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NEAX 2400 Commands

Use the NEAX 2400 Maintenance Administration Terminal (MAT) to enter 
these commands.

A knowledge of the D<Superscript>term stations in the NEAX system 
and which ones will have access to Dialer is necessary to use the 
following commands:

AOKC Command: (Assignment of OAI Key Codes)

This command is used to associate the MSF facility and its Op-Code that 
was configured for Dialer to one of the 14 OAI Key Codes in the MAT. 

• Select an unused OAI Key Code, from 1 to 14. To determine what Key 
Codes are available for assignment, use the LOKC command to list the 
AOKC Key Codes that are already assigned.

• Enter MSF as the facility to be assigned to the selected Key Code, 
using the values on the screen.

AKYD Command: (Assignment of D<Superscript>term Function 
Key)

This command is used to assign key data to the Dterm telephones that 
are to be used to access Dialer. 

MAT Function Key Indexes range from 34 to 47, have been designated 
for use in the OAI system, and correspond to the 14 OAI Key Codes as 
illustrated on the previous page. The AKYD command is used to assign a 
D<Superscript>term function key to the specific MAT Function Key 
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Index that, in turn, corresponds to the previously assigned OAI Key 
Code. This command must be used to assign the function key on each 
D<Superscript>term that is to be set up with access to Dialer. 

• Enter the station number of the D<Superscript>term on which the 
function key is being assigned.

• Enter in the Dterm function key field the MAT Function Key Index that 
corresponds to the previously assigned OAI Key Code.

Figure 4-2  OAI Function Key Assignment Example
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Example:

The example in Figure 4-1 indicates that MSF #129 is configured for 
Dialer and is assigned through the AOKC command to OAI Key Code 10. 
OAI Key Code 10 corresponds in the PBX to MAT Function Key Index 43. 
Each Dterm in the system that is to access Dialer has function key 3 
assigned to MAT Function Key Index 43 via the AKYD command. Now 
whenever a phone user presses function key 3 on any assigned Dterm, 
MSF 129 initiates communication with Dialer.

ASYD Command: (Assignment of System Indices)

Use ASYD to assign certain bits in System Index data as indicated 
below.

Index 27 Bit 6

0 Enable OAI

Index 63 Bit 6

1 Enable SMFN Call Forward Detail

Bit 7

1 Internal OAI 
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Index 79 Bit 6

0 Enable OAI/ACD

Index 241 Bit 2

1 LP sends SMFNs to IP

Bit 3

1 Enable Detail Error Codes

Index 370 Bit 0

1 Send expanded SMFNs including CCIS 
Link reconnect SMFNs needed

ASYDL Command: (Extended Assignment of System Indices)

This command is used to set system index bits as needed by most 
OW5000 applications. This command is not available on earlier versions 
of the PBX, such as the HDS or ICS.

Index 533 The FPC of the OAI node (or ACD if it 
exists) for all systems in the network

Index 864 Bit 0

1

Bits 2 & 3

Never 1 at same time

Bit 4

1 Enable 8-port mode to allow more than 
two applications to monitor the same 
device

Index 865 The FPC of the OAI node

Index 867 Bit 0

1 Send OAI SMFNs for Call Forward No 
Answer

Bit 4

1 Enable 16 digit extensions

Dialer is now installed and ready to be initialized on the NEAX 2400. 
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NEAX 2000 Commands

Use the NEAX 2000 Customer Administration Terminal (CAT) or the 
NEAX 2000 Maintenance Operations Console (MOC) to enter these 
commands. (Refer to the NEAX 2000 System Manuals for more 
information.)

Phone in CAT mode: (Assignment of CAT Mode)

Use this command to place the phone in CAT mode: 

Trans + Conf + *  + Trans + Conf + #

Once you are in CAT mode, the Buttons on the Dterm perform the 
actions listed in Table 4-1.

Table 4-1  Dterm Buttons—CAT Mode

Button Action

LNR/SPD or Redial Sets the PBX to command mode.

Conf Writes the data to memory.

Recall Acts like the Enter key to accept a selection. 

CMD79 Command: (Assignment of IP Address)

Use this command to assign the IP Address of TCP/IP-Ethernet.

1st data 00–03: Division No. of IP Address

2nd data 0–255: Address Data (1–3 digits)

The IP Address must be assigned to the 1st data 00–03 as listed in 
Figure 4-3.

Figure 4-3  Assignment of IP Address—CMD79

1st data (1)

00

01

02

03

IP Address: XXX • XXX • XXX

[XXX: 2nd data (2)]

• XXX



4-6         NEAX Command Assignments

OW5000 Dialer Installation Guide - Revision 10

CMD7 Command: (Assignment of MSF Operation Code)

Y=0: When pressing the OAI function key to start up MSF, assign the 
operation code to the OAI function key assigned by CM90.

1st data: F1033 Function Key Number 1

F1047 OAI Function Key Number 15

2nd data: 128–191: Operation Code for MSF

Y=0: When dialing a digit code (1–3 digits) after pressing OAI function 
key to start up MSF, assign the digit number of digit code, then assign 
the operation code to the digit code.

1st data: F1033 Function Key Number 1

F1047 OAI Function Key Number 15

2nd data: DCX (X=1–3) Operation Code for MSF

CM90 Command: (Assignment of the OAI Function Key for MSF)

Use this command to assign the OAI function key for starting up MSF to 
a Dterm.

1st data My line number +, + Key Number

2nd data F1033 Function Key Number 1

F1047 OAI Function Key Number 15
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CM65 Command: (Camp Recall)

The following settings should be applied to IPS F2 5.0.0 and above to 
prevent camped calls from recalling to the operator’s extension.

yy 27

1st data 1: Tenant number

2nd data 0: Send OAI SMFN-9 (Dialed Digits) for 
calls placed from an analog single line 
station

CM08 Command: (System Data)

The following settings should be configured to ensure proper behavior of 
OW5000 applications.

1st data 117

2nd data 0: When Station A is talking to Station B 
with external call on consultation hold 
screened transfer, and Station B hangs 
up, reconnect Station A to the held trunk 
call. 

1st data 177

2nd data 0: Send OAI SMFN-9 (Dialed Digits) for 
calls placed from an analog single line 
station

1st data 460

2nd data 0: Send OAI SMFN-1 (Incoming) STS=7 
(Blind Transfer) after a blind transfer

1st data 461

2nd data 0 Send OAI SMFN-2 (Answer) STS=2 (Held 
Call) when unholding a held call

1st data 462

2nd data 0 Send ANI/Caller ID/CPN to OAI terminal

1st data 464

2nd data 0: Do not send SMFN Off hook notification 
after SCF
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1st data 465

2nd data 0: Send SCF error detail

1st data 804

2nd data 0 Send station type (0=single line, 1=PS 
terminal) in OAI SMFNs

1st data 805

2nd data 0 Send OAI SMFN-3 (Release) STS=5 
(Abandon Call Forward) and SMFN-1 
(Incoming) STS=6 (Call Forward No 
Answer) when a monitored extension call 
forwards no answer

1st data 808

2nd data 0 Send OAI SMFN-2 (Answer) STS=5,6,7 
for answering Call Forward All/Busy/No 
Answer

1st data 809

2nd data 1 When answering a held call by SCF11, 
exchange the line information

1st data 811

2nd data 0 Send OAI SMFN-1 (Incoming) STS=4,5 
for incoming call that is Call Forward All/
Busy

1st data 815

2nd data: 0 Send OAI SMFN-1 (Incoming), STS=2 
(Recall) when held call recalls

1st data 817 New in R9

2nd data 0 Send OAI SMFN-1 (Incoming) and SMFN-
2 (Answer), STS=4,5,6/5,6,7 (Call 
Forward All/Busy/No Answer) when CF-
All Calls/Busy Line/No Answer call via 
CCIS is ringing/answered

1st data 818 New in R9

2nd data 0 Send OAI SMFN-6 (Hold), STS=2 
(Exclusive Hold) when call is put on 
exclusive hold
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